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1. INTRODUCTION
Thank you for choosing EM60 series data loggers from METER Group. 

The EM60 series loggers (EM60 and EM60G) are part of the ZENTRA System, a 
collection of data loggers, software, and compatible sensors to measure soil moisture 
and other environmental parameters accurately and cost effectively. Please refer to 
EM60 specifications at metergroup.com/em60-support for an up-to-date list of supported 
sensors.

The EM60 is a self-contained, plug-and-play data logger for field research and commercial 
agriculture. It is housed in a weather-resistant enclosure, making it suitable for long-term 
outdoor operation. The logger also includes built-in circuitry to charge nickel-metal hydride 
(NiMH) batteries using energy from an integrated solar panel.

The EM60 series includes two models: 
• EM60 is a manual-download logger.

• EM60G is a remote-download logger that communicates through a cellular module to 
transmit data over the internet. 

Throughout this manual, references to EM60 apply to both the EM60 and EM60G versions of 
the logger unless otherwise specified. 

Verify all instrument components are included and appear in good condition:
• EM60 series logger with five installed rechargeable NiMH batteries

• Micro-USB communications cable

• Zip ties for mounting the logger

• USB drive containing ZENTRA Utility software installer

• Antenna (EM60G)

• Device subscription card (EM60G) 

https://www.metergroup.com/em60-support
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2. OPERATION
This section explains the basic workflow of logger installation, logger configuration, and 
data download. Please read all instructions before operating the EM60 to ensure it performs 
to its full potential. Consider testing the EM60 and sensors in a lab or office prior to field 
installation to verify the correct operation of the system.

The EM60 can serve as a data collection station for as many as six sensors. It is designed 
to be a plug-and-play setup with all METER sensors, including the ECH2O water content 
sensors, ATMOS weather sensors, and TEROS soil moisture sensors. Please refer to the 
individual sensor manuals for sensor installation instructions.

2.1 INSTALLATION
Follow the steps listed in Table 1 to set up the EM60 and start collecting data.

Table 1 Installation

Tools Needed
Microsoft® Windows® or Apple® Mac® computer

Mounting post (or similar)

Preparation

Install ZENTRA Utility
Use the included USB drive to install ZENTRA Utility:
• On a Windows computer, open the My Computer window, select the USB drive, 

and double click on ZENTRA Utility PC Installer.exe.
• On a MacOS computer, using Finder®, select the USB drive, and double click 

on ZENTRA Utility Mac Installer.pkg.

Alternatively, use the ZENTRA Utility Installer link on the EM60 webpage 
(metergroup.com/em60-support).

The installer automatically installs the necessary USB driver for the EM60.

Remove Battery Pull-Tab
Inside the EM60, remove the battery pull-tab from the batteries.
NOTE: Alkaline batteries can be used in EM60 loggers but will not be recharged by the 
solar battery charger.

The status lights will eventually settle to a short, single blink every 5 s, 
signaling it is ready for use.

Attach Antenna (EM60G Only)
Remove the red connector cap from the antenna connector on top of the EM60G.

Twist the antenna directly onto the antenna connector.

https://www.metergroup.com/em60-support
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Table 1 Installation (continued)

Configuration

Configure the EM60 Using ZENTRA Utility
NOTE: This step can also be done in the field.

Connect the micro-USB cable to a computer and logger.

Open ZENTRA Utility and select Connect (Section 2.2).

Set the measurement interval and verify the EM60 is correctly configured for 
the sensors that will be installed. 
NOTE: By default, the EM60 is configured to store sensors readings every 15 min. 
Consider reinstalling the battery pull-tab until deploying the logger in the field.

Field Installation

Select Location
Choose a location and orientation to give the solar panel the maximum amount 
of sunlight. In the northern hemisphere, this will typically mean the data logger 
will face south; in the southern hemisphere, this will typically mean the data 
logger will face north.

Additional location considerations may include vegetation cover throughout the 
season, distance from power lines, minimal livestock, etc.
NOTE: If the location is in an area where solar energy harvesting is minimal, alkaline 
batteries will power the logger longer than the NiMH batteries when not being recharged 
by the solar panel. The EM60 does not charge alkaline batteries. 

For EM60G loggers, evaluate how surroundings may attenuate the cellular 
signal. Do not install EM60G loggers near large metallic objects.

Remove Battery Pull-Tab (if still installed)

Check Cellular Communication Quality (EM60G)
Use ZENTRA Utility to check the quality of the cellular signal (Section 2.3).

If the signal is low or cellular test fails, move to an alternative location 
(sometimes moving only a few meters is sufficient). 

Fasten Logger to Mounting Post
Use the loopholes on the top and bottom of the logger enclosure to mount the 
EM60 to a post using the zip ties or a similar fastener. 

Ensure the logger is installed in an upright position to reduce the possibility of 
water entering the EM60 enclosure.
NOTE: The EM60 case is water resistant, not waterproof. In extremely wet environments 
or environments with prolonged high humidity, enclose a desiccant packet inside the 
logger or enclose the logger in a waterproof case. 
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Table 1 Installation (continued)

Field Installation
(continued

Fasten Logger to Mounting Post
Use the loopholes on the top and bottom of the logger enclosure to mount the 
EM60 to a post using the zip ties or a similar fastener. 

Ensure the logger is installed in an upright position to reduce the possibility of 
water entering the EM60 enclosure.
NOTE: The EM60 case is water resistant, not waterproof. In extremely wet environments 
or environments with prolonged high humidity, enclose a desiccant packet inside the 
logger or enclose the logger in a waterproof case. 

Install Sensors
Install each sensor as directed in the sensor user manual. 

Thread cables in conduit or plastic cladding when near the ground to avoid 
rodent damage.

Plug the sensor plug connectors firmly into the EM60 input ports.

Secure sensor cables to mounting post with some cable slack between the 
EM60 and the post.

Perform instantaneous scan to ensure sensors are working properly (Section 
2.4).

2.2 CONFIGURATION
The measurement interval and sensor types must be set before data will be stored by 
the logger.

ZENTRA Utility (Section 4.1) is used to configure the operational parameters of both 
EM60 and EM60G. ZENTRA Cloud can also be used to remotely update most of the EM60G 
settings (Section 4.2). This manual will focus on the ZENTRA Utility software as the primary 
interface to the EM60. 

To configure EM60 in ZENTRA Utility, refer to the following steps:

1. Open the ZENTRA Utility application (Figure 1).
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Figure 1 ZENTRA Utility initial screen

2. Plug the micro-USB cable into the logger USB port and the computer USB port.

3. On the ZENTRA Utility main screen, select the appropriate COM port from the dropdown 
menu (Figure 2).

Figure 2 COM port dropdown

4. Click the Connect button next to the COM port dropdown menu (Figure 2).

Once successfully connected, ZENTRA Utility displays the instantaneous sensor 
measurements from the EM60 (Figure 3).
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Figure 3 EM60 connected and showing instantaneous measurements

5. Click the Settings button in the Button toolbar.

The Manage Settings dialog will appear.

6. Navigate to the Device Information tab (Figure 4).
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Figure 4 Device Information tab

7. Enter a device name.

This field is prepopulated with the device serial number. Consider changing the name to 
the field or plot where the EM60 is installed. 

8. Navigate to the Sensor Configuration tab (Figure 5).

Figure 5 Sensor Configuration tab
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9. Adjust the Measurement Interval to the desired time between storing sensor 
measurements.

Section 3.2.2 provides more information on how the EM60 makes sensor measurements.

10. Plug sensors into the EM60 sensor ports.

11. Ensure the correct sensor type is listed in each port tab (Figure 6).

If the sensor is not automatically recognized, pick the correct sensor setting from the 
Sensor Type dropdown menu.

NOTE: For EM60G, check the cellular signal (Section 2.3) at the expected installation location before 
installing sensors.

Figure 6 Select Sensor Type dropdown

12. If configuring an EM60 logger, click OK. This completes the configuration.

If configuring an EM60G logger, continue to step 13.

13. Navigate to the Communication Settings tab (Figure 7).
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Figure 7 Communication Settings tab (EM60G only)

14. Select the time segments in Upload Times by clicking the arc segments for the hour 
intervals.

EM60G will upload data during the selected intervals (Section 4.1.6).

15. Click OK.

2.3 CELLULAR COMMUNICATION TEST (EM60G ONLY)
A successful communication test will confirm that the EM60G can transmit data to servers 
as well as the strength of that connection. Even a poor connection indicates that data are 
being successfully transferred. Prior to installing the sensors and EM60G, check the cellular 
connection at the location:

1. Click the Cellular Test button in the Button toolbar.

The Cellular Communication Test dialog will appear (Figure 8).
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Figure 8 Cellular Communication Test dialog

2. Click Test.

3. If the logger fails the test, move to a new location and try again.

Sometimes, even moving just a few meters will provide a successful connection. 

NOTE: For increased signal strength, the antenna should be unobstructed by structures or vegetation. Consider 
the expected growth of plant canopy around the antenna. An antenna extension cable can also be used to elevate 
the antenna for increased signal strength. 

4. Click Close.

2.4 INSTANTANEOUS SENSOR MEASUREMENTS SCAN
ZENTRA Utility will automatically scan the sensors attached to the EM60 every 30 s and 
update the readings shown on the main screen (Section 4.1.3).

ZENTRA Utility can also take real-time sensor measurements with the EM60 on demand. 
This is a critical tool to ensure sensors are installed correctly, to test if a sensor is reading 
properly, or to evaluate how sensors react to environmental changes. The EM60 does not 
store data that it measures with the scan function.

To force a new scan to occur at any time, press the Scan button in the Button toolbar 
(Section 4.1.1). The sensor and measurement area will refresh.

2.5 DATA DOWNLOAD 
While at the installation site, allow the EM60 to collect data for one or two measurement 
intervals, and download the collected sensor data to ensure the monitoring setup is working 
correctly. Periodically return to the site to download the stored data to check the logger 
operation and to retrieve stored data.

Download saved sensor and status data with ZENTRA Utility using the following steps: 

1. Connect the logger to a computer using the micro-USB cable.

2. Open ZENTRA Utility.



11

EM60

3. Choose the appropriate COM port from the dropdown list.

4. Click Connect.

5. Click Download on the Button toolbar. This will download the data stored since the last 
successful download.

Alternatively, go to the Data menu in the Menu bar and select either Download New 
(downloads the data stored since previous download) or Download All (downloads all the 
data currently stored in the EM60).

6. Edit the File Name in the Save dialog. A suggestion will appear, based on the connected 
logger name and the time and date. 

7. Select the location on the computer where the file will be saved.

8. Click Save.

ZENTRA Utility downloads sensor data and creates a Microsoft® Excel® compatible file. 
The time-series sensor data saves to the Processed Records sheet of the workbook with 
metadata saved to the Metadata sheet. Metadata includes logger configuration settings, 
logger location, and sensor metadata, such as serial number and firmware version.

ZENTRA Utility will download data in the units chosen under Measurements in Manage 
Preferences dialog (Section 4.1.5). 

The EM60G was designed to send measurement data to zentracloud.com using the cellular 
network. After these data are uploaded, they are available for viewing and downloading in the 
ZENTRA Cloud application (Section 4.2).

2.6 DATA DELETION
It is not necessary to delete data on the EM60 once all of the memory has been used. The 
EM60 will start overwriting the data starting with the oldest records.

Erasing data stored on the EM60 is done with ZENTRA Utility. Before erasing data, download 
and save data onto a computer. To erase data, follow the steps below:

1. In ZENTRA Utility, click on the Data menu on the Menu bar.

2. Select Erase. A dialog will appear.

3. Click Erase Data to remove data.

Click Cancel to return to ZENTRA Utility without removing data.

CAUTION: This feature permanently erases all stored data on the EM60. Data previously transmitted to ZENTRA Cloud 
are not erased.

https://www.zentracloud.com
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3. SYSTEM
This section reviews the EM60 data logger hardware features and configuration options. Use 
this information to help optimize each environmental monitoring setup.

3.1 SPECIFICATIONS
Sensor Input Ports 6 (supports METER analog, digital, or pulse sensors)

Sensor Port Type 3.5-mm stereo plug connector

Logging Interval
1 min to 12 h (EM60)

5 min to 12 h (EM60G)

Reporting Interval 
(EM60G)

Hourly with additional charges for more frequent reporting

Data Storage 8 MB (40,000 to 80,000+ records depending on configuration)

Memory Type Nonvolatile flash, full data retention with loss of power

Global Position Integrated 56-channel GPS/QZSS receiver

GPS Position Update Daily (automatic) and on-demand (manual)

GPS Position Accuracy ±3 m, with good sky view

Timekeeping
Synchronize automatically and on-demand; 
GPS system, cellular (EM60G), or software

Battery Capacity Five AA NiMH or alkaline batteries

NiMH Battery Charging Solar energy harvesting or USB

NiMH Battery Life 3+ years with unobstructed view of sun

Alkaline Battery Life
18 to 24 months (EM60)

3 to 12 months depending on configuration (EM60G)

Computer Communication Standard USB cable, USB A to micro-B

Cellular (EM60G) UMTS 3G 5-band Cellular Module with 2G fallback

Cellular Coverage
AT&T and T-Mobile in USA, 200+ global partner carriers. 

Cellular and data hosting service provided by METER.

Internet Downloads SSL/TLS encrypted

Enclosure Weather-, impact-, and UV-resistant polymer

Enclosure Size 12.7 cm × 20.3 cm × 5.1 cm (5 in × 8 in × 2 in)
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Enclosure Access Hinged door with latches and eyelet for lock or zip tie

Operating Environment –40 to +60 °C (0% to 100% relative humidity)

Compliance
Manufactured under ISO 9001:2015

EM ISO/IEC 17050:2010 (CE Mark)

3.2 EM60 HARDWARE COMPONENTS
The EM60 logger series (Figure 9) includes two models: 
• EM60 is a basic logger that communicates through a micro-USB cable to a computer.

• EM60G is a logger that, in addition to USB communication, also communicates through 
a Universal Mobile Telephone Service (UMTS) cellular module. This allows remote 
configuration and environmental measurement data transmission over a cellular network. 

Figure 9 EM60G data logger exterior. EM60 is identical, without an antenna.
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The logger is housed in a weather-resistant enclosure. In extremely wet environments or 
environments with prolonged high humidity, enclose a desiccant packet inside the logger or 
enclose the logger in a waterproof case.

EM60 is purpose-built to collect data from environmental sensors sold by METER. The data 
logger has six ports for sensors and a micro-USB port for communicating with a computer 
(Figure 10). The data logger interior also contains a TEST button (Section 3.2.3) and two 
status lights, OK and ERROR (Section 3.2.4). The logger uses five batteries, and solar cells 
will recharge NiMH batteries (Section 3.2.5). 

ERROR
OK

TEST

(–)

(+)

(–)

(+)

(–)

(+)

(+)

(–)

(+)

(–)

P1 P2 P3 P4 P5 P6

Figure 10 EM60G data logger interior. EM60 is identical.

3.2.1 SENSOR INTERFACE
EM60 will detect the presence of most types of sensors when connected to the sensor ports. 
The EM60 will detect METER digital sensors and autopopulate the Sensor Type dropdown 
on the Manage Settings dialog in ZENTRA Utility (Section 4.1.6). For METER analog sensors, 
the EM60 will show Unrecognized Sensor in the Sensor Type dropdown. Some sensors (such 
as pulse sensors) will not be detected by the EM60. In these latter two cases, the sensor will 
have to be manually selected from the dropdown menu.

NOTE: It is critical that the EM60 is configured correctly for the attached sensors. Without correct configuration, the 
EM60 will not record useful sensor information.
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The EM60 is able to detect when many of the METER sensors are unplugged or 
malfunctioning. The logger stores error codes in the place of normal sensor measurements 
in this event. ZENTRA software will display these errors to help troubleshoot problems with 
the sensors. The EM60 cannot determine the difference between an intentionally uninstalled 
sensor and a malfunctioning sensor. Update the sensor configuration if sensors are removed 
from or added to the EM60.

3.2.2 SENSOR MEASUREMENT INTERVAL
The measurement interval controls how often the EM60 records sensor data to internal 
nonvolatile data storage. The interval applies to all ports on the EM60 (i.e., EM60 
cannot store data for one sensor at a faster rate than another sensor). This setting is 
controlled in the Sensor Configuration tab of the Manage Settings dialog (Section 4.1.6).

The measurement interval works relative to the EM60 internal real-time, 24-h clock. For 
example, a measurement interval of 2 h results in the EM60 storing data every 2 h, on the 
hour (e.g., 12:00 am, 2:00 am, ..., 10:00 pm). The EM60 and EM60G support 1 min and 5 min, 
respectively, as the minimum value for the measurement interval setting. The maximum 
measurement interval for both models is 12 h. For most applications, a measurement 
interval of 15 min is appropriate.

The EM60 makes a measurement from each of the six sensor ports in use every 60 s. 
When the EM60 internal clock reaches the user-configured measurement interval, the 
EM60 processes and stores the results from all the 60-s sensor readings taken since the last 
storage interval. For most sensors, the stored results are a simple average of the per-minute 
readings. For example, if the measurement interval for a GS3 soil moisture sensor is 60 min, 
the EM60 stores an average of the past 60 sensor readings. Data are summed for pulse-
based sensor like a rain gauge. Some METER sensor user manuals contain more details of 
how the EM60 processes sensor readings.

NOTE: Setting the EM60 measurement interval to Off (not logging) turns off sensor measurement, data storage, and 
EM60G data uploads.

3.2.3 TEST BUTTON 
Pressing the TEST button initiates the self-test sequence. For EM60 loggers, the self-test 
takes about 6 s to complete. For EM60G loggers, the self-test can take 60 s or more because 
of testing communications over the cellular network. The following actions are part of the 
self-test sequence:

1. Reboot the EM60.

This ensures internal software restarts and is operating in the expected way. Both status 
lights stay lit during the reboot. This reboot will not erase data or reset settings.

2. Perform basic functionality testing on internal systems and evaluates the amount of 
charge in the battery.

Both the green and red lights blink together slowly while the logger performs tests.

3. Autodetect the connected sensors (Section 3.2.1).
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4. Start the embedded GPS receiver to obtain a current time and location fix (Section 3.2.6). 

This process takes up to 15 min to complete.

5. Establish an internet connection over the cellular network and attempt to communicate 
with ZENTRA Cloud (EM60G only). 

After completing the self-tests, the EM60 will indicate success or failure by lighting either 
the red or green status light. 
• A solid green light (for approximately 20 s) indicates that internal tests passed and, if 

applicable, there is successful communication over the cellular network.

• A solid red light indicates an error in the logger, which may include:

 � Corrupt EM60 logger firmware

 � Low batteries

 �Unsuccessful EM60G communications

Use ZENTRA Utility to identify where the self-tests may have failed (Section 4.1) or consult 
troubleshooting to resolve logger errors (Section 5.2).

3.2.4 STATUS LIGHTS 
Lights near the TEST button indicate the status of the EM60. A green light is labeled OK and a 
red light is labeled ERROR. There are several possible status states:
• The green light gives a short, single blink every 5 s to indicate the EM60 is configured to log 

sensor data.

• The green light blinks slowly (1 s on, then 1 s off), to indicate the logger is communicating to 
a computer or using the cellular module.

• The green and red lights blink together during self-test procedures (after pressing the TEST 
button or pulling the battery tab). 

At the conclusion of the self-tests, either the green or the red light will remain lit to indicate 
the results of the test.

• The lights remain off if the logger measurement interval is set to Off (not logging).

3.2.5 BATTERIES 
The EM60 is designed to use either AA NiMH rechargeable batteries or AA alkaline 
nonchargeable batteries. The logger autodetects the type of batteries installed and 
automatically adjusts the internal thresholds to represent 100% and 0% battery power.

NOTE: Do not mix NiMH and alkaline batteries together. Do not mix new and old alkaline batteries together.

Use NiMH batteries if the EM60 will be installed outdoors, where it can harvest solar energy 
to charge NiMH batteries. Orient the EM60 enclosure to expose the solar panel to the 
maximum amount of sunlight available. In the northern hemisphere, this typically means 
that the data logger will face south; in the southern hemisphere, this typically means 
that the data logger will face north. There may be local obstructions that make another 
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orientation more favorable. The logger will charge the batteries even during periods of low 
light levels (e.g., winter time or heavy overcast conditions). For extended periods of low 
light, the incoming energy may be lower than the energy needed to operate the logger. The 
batteries will buffer the energy needs of the logger for several months and will return to full 
capacity as the incoming energy exceeds the energy needed to operate the logger.

The EM60 will also harvest energy from the USB connection to a computer. Plugging the 
logger into a USB port for several hours will help restore NiMH batteries to full capacity.

Use alkaline batteries if the EM60 will be installed indoors or in a location where the 
harvested solar energy is not sufficient to keep the NiMH batteries charged. Alkaline 
batteries will last longer than NiMH batteries that are not being charged (6 to 7 months for 
an EM60G; more than 2 years for an EM60).

The EM60 is designed to prioritize sensor measurements over both the GPS and cellular 
communications features. If the battery level reaches a critical threshold (showing 0% in 
software), the logger will stop using the GPS receiver and the cellular radio (EM60G). The 
logger will continue to make sensor measurements until the battery charge is too low to 
provide excitation power to the sensors. When new batteries are installed or recharged, the 
GPS receiver and cellular radio functionality will automatically start working again. 

Logged data is stored with nonvolatile flash memory and will not be lost if battery power 
fails. However, power must be restored to the logger to download data. 

3.2.6 GPS RECEIVER
The EM60 logger has a built-in GPS receiver that provides the latitude, longitude, and 
altitude of the logger. It is designed to provide a time fix and location metadata for the 
environmental monitoring location. The EM60 does not record the location of each 
individual sensor reading and is not optimized for applications such as geotagging a moving 
sensor platform.

The EM60 enables the GPS receiver once per day. If the logger determines its location has 
not changed, it turns off the GPS receiver to save power. If the EM60 detects a change, it 
keeps the GPS receiver powered for as long as 15 min to improve the accuracy of the location 
fix. Pressing the TEST button on the EM60 triggers the logger to evaluate changes in location 
(Section 3.2.3).

3.2.7 TIMEKEEPING
The EM60 keeps track of time using Universal Time Coordinated (UTC) seconds. The 
EM60 synchronizes time using either a computer running ZENTRA Utility or the GPS receiver. 
The EM60G can also synchronize time with the cellular network and ZENTRA Cloud. The 
EM60 prioritizes using GPS time since this will be the most accurate; however, the logger will 
fall back to the other sources of time when the EM60 does not have a good GPS time fix.
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Data collected by the EM60 uses the UTC time for timestamp on each saved sensor record. 
ZENTRA Utility and ZENTRA Cloud display these data using local time based on where the 
logger is installed. The EM60 time zone setting calculates local time for the logger and is set 
by the computer running ZENTRA Utility or by the cellular network (if the network supports 
this feature).

3.2.8 DATA STORAGE
The EM60 only stores data for sensor ports that are configured for sensors (Section 3.2.1).  

The EM60 stores up to 8 MB of data. When the logger has filled its memory, it begins 
overwriting the oldest data in the memory. Data storage varies between approximately 
6 months to over 300 years depending on the sensors used and the measurement interval. 
ZENTRA Utility software displays how many days of data the EM60 can hold based on 
the current measurement interval (Section 3.2.2), sensor configuration, and previously 
stored data .

The EM60 data memory is nonvolatile flash. Removing the batteries or rebooting the logger 
(Section 3.2.3) will not erase stored sensor measurement data.

The EM60 stores encoded data for each sensor to make data storage and transmitting 
convenient. ZENTRA software automatically decodes the sensor data to display them 
correctly.

3.2.9 CELLULAR COMMUNICATIONS (EM60G ONLY)
The EM60G has a built-in cellular module for uploading measurement data to ZENTRA Cloud. 
This allows for near real-time monitoring of the environment at the measurement site. 

The EM60G powers the cellular module only long enough to upload the data collected 
since the last time the logger successfully reported. During these upload times, the EM60G 
transfers data to ZENTRA Cloud and retrieves any pending settings changes. 

Upload session frequency and timing can be changed in ZENTRA Utility (Section 4.1.6) 
or ZENTRA Cloud. The default setting is for the EM60G to upload data once per hour at a 
random time within each hour of the day. Less frequent uploads conserve battery power.

NOTE: Contact Customer Support if more frequent uploads are needed.

The EM60G operates with AT&T® and T-Mobile® networks in the United States. The EM60G 
also works with over 200 roaming partners around the world.
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4. ZENTRA SOFTWARE
The EM60 is designed to work with ZENTRA Utility and ZENTRA Cloud. Both ZENTRA 
Utility and ZENTRA Cloud software allow the user to collect and manage data from the 
device. ZENTRA Utility is on the included USB drive or can be downloaded from  
metergroup.com. ZENTRA Cloud is a web-based application to remotely download 
spreadsheets, view data, and configure the EM60G (Section 4.2).

NOTE: ZENTRA Utility does not communicate with an EM60G logger over the cellular network and internet. The logger 
must be physically plugged into the computer to download data via ZENTRA Utility. Use ZENTRA Cloud to download 
EM60G data when not directly connected to the logger.

4.1 ZENTRA UTILITY 
ZENTRA Utility is a user-friendly interface for configuring and downloading data from the 
EM60 logger that can be used on any MacOS (10.9 and above) or Microsoft Windows (7 and 
above) laptop, netbook, or desktop computer. With ZENTRA Utility, the user can
• connect to EM60 loggers directly,

• set all logger configuration parameters,

• make real-time sensor measurements (scan sensors), and

• create Excel files with sensor data.

The ZENTRA Utility main screen should appear upon launch (Figure 11). Use the Menu bar 
and Button toolbar to interact with the EM60.

Menu bar

COM port dropdown

Button toolbar

Device serial number

Active sensors and 
measurements

Battery status

Device name

Measurement interval

Site name

Device firmware version

Status bar

Memory usage

Data logger 
identification area

Figure 11 ZENTRA Utility Main Screen

https://www.metergroup.com
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4.1.1 BUTTON TOOLBAR 
The Button toolbar provides shortcuts for the most frequent actions in using and configuring 
EM60 (Figure 11):
• COM port dropdown menu: Lists USB devices connected to the computer.

• Connect/Disconnect: Click the Connect button to attempt to connect to the device 
currently selected in the COM port dropdown menu. Click the Disconnect button to 
disconnect from the currently connected logger.

• Scan: Queries the connected EM60 for the current sensor readings and updates the active 
sensors and measurements area.

• Download: Downloads all data that has been collected on the EM60 since the last time a 
download from the selected logger.

• Settings: Opens the Manage Settings dialog (Section 4.1.6).

• Cellular Test: Opens the Cellular Communication Test dialog (Section 2.3).

Figure 12 Button toolbar

4.1.2 DATA LOGGER IDENTIFICATION AREA
The Data Logger Identification area shows information for the connected EM60. Hover over 
each item for its label. Any customizable fields can be adjusted through the Manage Settings 
dialog (Section 4.1.6).
• Serial Number: The factory-set unique serial number for each EM60.

• Device Type: Model, either EM60 (logger without cellular) or EM60G (logger with cellular).

• Site Name: Customizable field to describe the EM60’s location.

• Remaining Battery Life: Icon that shows the battery charge remaining on the device.

• Cellular Strength: Icon that shows the strength of the cellular signal. This appears only 
after the cellular communication test is completed (Section 2.3).

• Device Name: Customizable field to describe the EM60 device.

• Firmware Version: Version of firmware on the EM60.

• Measurement Interval: Customizable field that describes the frequency at which the 
EM60 will be recording measurements (Section 3.2.2).

• Time until Overwriting Data: Indicator of how much data is stored on the EM60 and how 
long it will be able to record more measurements before overwriting older data.
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4.1.3 ACTIVE SENSORS AND MEASUREMENTS AREA
All sensors plugged into the EM60 are listed in this area and each sensor in this section is 
delimited by a horizontal bar. The left side of the section will have the sensor name and port 
number. The two on-board sensors (Battery and Barometer) will not show a port number. 
The right side of the section will list all measurements from the sensor, with a descriptor of 
the value. The measurements will use the units selected in the Manage Preferences Dialog 
(Section 4.1.5).

4.1.4 STATUS BAR
The Status bar in the bottom border of the screen will include what is happening in the 
software. It also shows the logger date and time. 

4.1.5 MENU BAR
ZENTRA Utility Menu bar has six menus to access the program features: File, Data, Edit, 
Actions, Window, and Help. 

FILE MENU
The File menu includes four options:
• Disconnect: Disconnect from a logger and end communications.

• Stitch Together Excel Files: Appends EM60 data by date from multiple Excel files into a 
single Excel file.

• Separate Excel Files:  Separates a single EM60 Excel file into multiple Excel files by 
configuration type and then by every 65,000 measurements.

• Exit: Closes ZENTRA Utility.

DATA MENU
The Data menu has three options:
• Download Data Since Last Download: Download the data stored since the last successful 

download.

• Download All: Download all the data currently stored in the EM60.

• Erase: Deletes all stored data.

Section 2.5 provides instructions for downloading data from the EM60 logger. 

Most sensors compatible with the ZENTRA system do not require per-sensor calibration. 
The data downloaded by ZENTRA Utility will be calibrated correctly for each sensor type. 
The exception are soil moisture sensors that may require custom calibration for the soil type 
where they are installed. ZENTRA Utility uses a default calibration for soil moisture sensors 
that is appropriate for most mineral soils. If it is necessary to use a different soil moisture 
sensor calibration, change the Measurement Units to Raw VWC in the Manage Preferences 
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tab. Raw VWC values will be downloaded in the Processed Data worksheet and are available 
as inputs to custom calibration equations. See each specific sensor manual for alternative 
calibrations that can be applied to the raw data. 

EDIT MENU
The Edit Menu allows the user to edit preferences in the Manage Preferences dialog. These 
preference configurations will only be saved to the computer, not as measuring preferences 
in the EM60 memory. It has four tabs for navigation:
• Measurements tab (Figure 13):

 �Measurement Units: Set preferences for measurement units by using the dropdown 
menus. Click OK to apply the changes.

Figure 13 Measurements tab
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• Data File tab (Figure 14):

 �Date and Time Display in ZENTRA Utility: Change the format of date and time values 
by selecting an option from the dropdown menus. This controls how date and time are 
shown in ZENTRA Utility display and in the downloaded files.

Figure 14 Data File tab

• Application tab (Figure 15):

 � Automatic Internet Version Check: Select the checkbox next to automatically be notified 
when a newer ZENTRA Utility version becomes available. Updates can be searched for 
manually at any time in the Help menu.

 � Automatic Clock Synchronization: Select the checkbox to keep the device clock 
synchronized with the connected computer’s clock. The date and time can also be 
updated by using the Actions menu.

If the computer will not always have the correct time zone setting for the logger sites, 
deselecting this option will not override the setting in the logger.
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Figure 15 Application tab

• Communications tab (Figure 16):

 �Device Commands Retries: Modifies the number of times ZENTRA Utility sends 
commands to a logger.  

 � Communication Ports List: Enable this option if the USB device does not appear in the 
Connect dropdown list.

NOTE: Enabling this option may also find COM ports that are unavailable for use by ZENTRA Utility.

 � Power Noise Filter: Set the Power Frequency to eliminate electrical noise that comes 
from an AC power distribution system.

In North America and most of Asia, the frequency of the power cycle is 60 Hz (the default 
value); in most of Europe it is 50 Hz. This feature only needs to be set once, and the 
program will automatically update each connected device filter.
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Figure 16 Communications tab

ACTIONS MENU
The Actions menu is the primary menu for configuring and testing the EM60 series logger.
• Select Sensors: Displays the Sensor Configuration tab in the Manage Settings dialog 

(Section 4.1.6).

• Set Device Time: Instructs ZENTRA Utility to set the EM60 time and date according to the 
time and date on the computer.

• Digital Sensor Terminal: Sends commands through the EM60 logger to a compatible METER 
digital sensor.

This feature can be used to troubleshoot the sensor by sending SDI-12 digital sensor 
communication commands. See respective sensor documentation for additional 
information on SDI-12 commands. 

• Cellular Test: Evaluates the EM60G logger wireless signal (Section 2.3).

• Cellular Configure: Displays the Communication Settings tab in the Manage Settings dialog 
(Section 4.1.6).

• List Cellular Carriers: Queries the cellular module in the EM60G logger for a list of carriers 
it detects. This is useful when trying to troubleshoot cellular connection problems. 

NOTE: EM60G may not be authorized to operate on any or all the carriers listed.
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• Device Information: Displays the Device Information tab in the Manage Settings dialog 
(Section 4.1.6).

• Device Location: Displays the GPS Location tab in the Manage Settings dialog (Section 
4.1.6). These are read-only fields because the logger has an on-board GPS module. 

• Show Raw Data/Show Processed Data: Toggle showing raw or processed data in the 
instantaneous measurements area of the main screen. Use the raw data display to help 
troubleshoot poor sensor measurements. 

WINDOW MENU
The Window menu provides the Show Terminal option. This allows for direct entry of 
commands to the EM60 and is mainly used for troubleshooting.

HELP MENU
The Help menu has five options.
• Check for Software Updates: Checks for the newest available version of the ZENTRA Utility. 

If a newer version is available, a prompt will appear to install the update. The computer 
must be connected to the internet for this feature to work. ZENTRA Utility checks for 
newer versions of the program each time it launches. It will download these updates in the 
background automatically. 

• Check for Logger Firmware Updates: Checks for the newest version of EM60 firmware from 
METER. If a newer version is available, ZENTRA Utility downloads the new firmware in the 
background. When ZENTRA Utility connects to an EM60, it compares the firmware on the 
logger with the latest version available. If the EM60 firmware is out of date, ZENTRA Utility 
will prompt to start a firmware update for the logger. ZENTRA Utility maintains a cache of 
logger firmware to allow field firmware updates without a connection to the internet.

• Update Sensor Firmware: Some METER sensors (e.g., ATMOS and TEROS sensors) allow 
for firmware updates via ZENTRA Utility. Please consult the sensor user manual for 
more details. 

• Send Feedback to METER: Sends product feedback, bug reports, or feature requests to 
METER when connected to the internet (Figure 17). 
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Figure 17 Send Feedback to METER Group window

Enter name, company name, and contact information in the form. 

Identify the type of feedback being sent (general feedback, feature suggestions, bug report, 
or other).

Indicate how METER should respond (email or telephone).

Give details in the description area. If reporting a bug, detail what steps occurred prior to 
the bug and any error message. By default, bug reports include software error files. Other 
files can also be sent using this form (e.g., logger download files).

• About ZENTRA Utility: View the version of ZENTRA Utility currently installed. 

4.1.6 MANAGE SETTINGS DIALOG
Changing the EM60 configuration happens in the Manage Settings dialog, which has four 
tabs. To access the Mange Settings dialog:

Click Settings on the Button toolbar (Section 4.1.1).

6. Make edits to the settings on the tabs. Refer to the details about the types of control 
settings in the following sections.

7. Click OK to save settings.

Click Cancel to exit without applying settings.
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DEVICE INFORMATION TAB
Use the Device Information tab to edit the information that appears in the Data Logger 
Identification area (Figure 18).
• Device Name: Logger-specific name to identify the logger in the software. The default name 

is the unit serial number. It can be changed to a name representing the field or plot where 
the logger is installed or the types of sensors installed.

• Site Name: Area-specific name to identify where a group of loggers are located in the 
software. The Site Name is optional. 

• Serial Number: Factory-set logger serial number that cannot be changed. 

• Time Zone: Time zone automatically set from ZENTRA Utility software or the cellular 
system (EM60G).

• Firmware Version: Version of firmware on the EM60. Check for the latest version of logger 
firmware, using the Help menu (Section 4.1.5).

• Device Type: Model of the ZENTRA logger connected to ZENTRA Utility (not editable). 

Figure 18 Manage Settings Device Information tab

SENSOR CONFIGURATION TAB
Use the Sensor Configuration tab to set the sensor measurement interval and to select 
sensors for each port (Figure 19).

• Measurement Interval: Controls how often the EM60 stores sensor data (Section 3.2.2).

NOTE: Setting the EM60 measurement interval to Off (not logging) turns off sensor measurement, data storage, and 
data uploads (EM60G).
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• Data Storage: Shows the percentage of logger storage currently used and an approximation 
of when the logger will begin overwriting the oldest data. This calculation is based on the 
data already stored, measurement interval, and existing sensor types configured in each 
port of the logger. 

• Sensor port tabs: Displays sensor type and firmware version (when applicable) for 
each sensor port on the logger. Select the correct sensor type from the dropdown menu to 
ensure correct sensor measurements.

NOTE: Only digital sensors have firmware versions.

Figure 19 Manage Settings Sensor Configuration tab

COMMUNICATION SETTINGS TAB (EM60G)
Use the Communication Settings tab to control upload frequency and times for the EM60G 
(Figure 20).
• Upload Frequency for each selected hour: Enable or disable automatic data uploads from 

the EM60G to ZENTRA Cloud. The Upload Frequency describes how often data are uploaded 
each hour and is a different setting than the sensor measurement interval. Data are sent 
once per hour. If more frequent uploads are needed, please contact Customer Support. 
METER offers cellular service plans that support uploading data every 15 min.

• Upload Times: Choose the approximate times of day that data are uploaded from the logger 
to ZENTRA Cloud. The data will be uploaded at a random time during each selected hour to 
upload data. To account for this variation, choose times prior to when the data is needed. 
By default, the EM60 is configured to upload data each hour. To conserve battery power, 
choose fewer upload times.
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Figure 20 Manage Settings Communication Settings tab

GPS LOCATION TAB
All information in this tab are automatically provided by the GPS receiver in the EM60 and 
are read only (Figure 21).
• Latitude/Longitude: Provides GPS location of the EM60. 

• Altitude: Contains altitude from sea level of the EM60.

• Time Zone: Offset from UTC time zone of the EM60.
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Figure 21 Manage Settings GPS Location tab

4.2 ZENTRA CLOUD (EM60G ONLY) 
ZENTRA Cloud is a cloud-based web application to download, view, and share EM60G data 
as well as change logger configurations. ZENTRA Cloud is also designed to make it easy to 
share data with colleagues. This manual offers only an introduction to ZENTRA Cloud. Use 
the online help files to learn more about all the features of ZENTRA Cloud.

The first step to using the EM60G with ZENTRA Cloud is to create a customer site (a group of 
users and loggers). 

1. Navigate to zentracloud.com.

2. Click the Sign Up button on the left side of the screen.

3. Enter the required information, including a valid email address. 

4. Accept the terms and conditions.

5. Click Sign Up.

ZENTRA Cloud will send an email confirmation.

6. Click the link in the confirmation email inside email application.

7. Log in to ZENTRA Cloud.

https://www.zentracloud.com
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To view data from EM60G loggers, subscribe to each desired EM60G logger on ZENTRA Cloud 
following the steps below. A logger can only belong to one site at a time.

NOTE: Depending on the organization, labels may be Farm and Field or Site and Plot.

1. Select New Farm on the lower left corner of the ZENTRA Cloud home screen.

2. Give the Farm a name.

A Farm can contain one or more Fields.

3. Select New Field from the button on the lower left corner.

4. Associate this Field to the Farm.

5. Give the Field a name. 

A Field can contain one or more loggers.

6. Select New Subscription from the button the lower left corner.

7. Choose the Farm and Field.

8. Fill in the EM60G Device Serial Number and Device Password as shown on the device 
subscription card (Figure 22).

  Device Subscription
Device Serial Number:

06-00998
Device Password:

12345-67890
Server:

zentracloud.com

Use this unique Device Serial Number
and Device Password to subscribe to 
this logger on zentracloud.com

      Keep this card in a safe place.
Do not leave it inside the device case.

Figure 22 Device subscription card

Once subscribed to an EM60G, the logger should appear on the map and sensor data can 
be viewed and downloaded. Logger settings can be changed using ZENTRA Cloud. ZENTRA 
Cloud also provides a convenient way to share data from EM60G loggers with colleagues, 
with user-set permissions. See the online help files for more information.
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5. SERVICE
This section describes the maintenance of the EM60. Troubleshooting solutions and 
customer service information are also provided.

5.1 MAINTENANCE
EM60 may be returned to METER for maintenance (inspect system, replace old or damaged 
parts, or update firmware). Select replacement parts (e.g., USB cable, antenna, case 
enclosure, gaskets) can also be ordered from METER. Contact Customer Support for more 
information. ZENTRA Utility makes it easy to send feedback, bug reports, and feature 
requests to METER (Section 4.1.5).

The EM60 requires little maintenance when installed correctly. Be sure to check EM60 logger 
periodically:
• Replace batteries as needed.

• Inspect the battery holders to ensure they are clean and free of corrosion.

• Verify that the sensor ports are clean and that the sensors are making good contact with 
the ports.

Clean the inside of the sensor ports with isopropyl alcohol and a swab if soil or other 
foreign materials are visible. 

• Check case gaskets and sensor cable strain relief. Replace gaskets every 1 to 2 years as 
needed.

• Replace zip ties securing the logger annually or as needed.

NOTE: Never immerse the EM60 in liquids or bury the EM60. This and other misuse, improper protection, or improper 
installation may damage the EM60 and void the manufacturer’s warranty.

NiMH batteries should last for several years if they are charging properly. Over a long period 
of time, NiMH batteries will begin to lose their charge capacity. If dark periods lasting 
months cause the batteries to discharge too low, it is time to replace the NiMH batteries. 
When replacing NiMH batteries, use high-quality batteries advertising higher charge 
capacity. New NiMH batteries may also be purchased from METER. Contact Customer 
Support to discuss concerns or recommendations. 

Alkaline batteries should be replaced when the battery charge nears 0%. Replace batteries 
with high-quality alkaline batteries. A low-quality battery may not provide the desired 
battery life for the EM60 logger.

NOTE: Do not mix NiMH and alkaline batteries together. Do not mix new and old alkaline batteries together.

NOTE: Installing or replacing the batteries in the EM60 resets the internal real-time clock. The EM60 time can be 
set from ZENTRA Utility, the on-board GPS receiver, and the cellular network (EM60G). Press the TEST button after 
changing the batteries to enable the GPS receiver to acquire a new time and position fix.
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5.2 TROUBLESHOOTING
Although METER designed the EM60 for durability and built to the highest manufacturing 
standards, problems may occasionally occur. This troubleshooting section details the major 
problems and their solutions. If the problem is not listed or these solutions do not solve the 
issue, contact Customer Support.

Table 2 Troubleshooting EM60

Problem Possible Solutions

ZENTRA Utility cannot 
connect to the device
or
EM60 logger not showing in 
the COM port picker

If using a Windows computer, reinstall the USB driver from  
metergroup.com/em60-support. 

Mac computers running ZENTRA Utility do not require a custom 
USB driver.
NOTE: The Em50 driver and USB Cable Adapter will not work for the EM60.

Check that the USB cable is securely plugged into the logger and 
the computer.

Ensure the logger has good batteries. 

Press the TEST button on the logger to reset it.

Connect to a second logger. If the connection works, the problem is 
likely with the first logger. 

Try a different micro-USB cable. Ensure the cable is not intended 
for charging only.

ZENTRA Utility reports it lost 
the connection

Check or replace the USB cable.

Increase the number of times ZENTRA Utility tries sending 
commands to the logger:
• Go to the Manage Preferences menu.
• Select the Communication tab.
• Increase the Direct Connect Retries.

ZENTRA Utility states 
there is no new data for 
downloading
or
Logger stopped making 
measurements

Wait for at least the length of the measurement interval to ensure 
the logger had enough time to record data.

Ensure the logger is configured to measure data, i.e., make sure the 
measurement interval is not set to Off (not logging).

Check the battery. The EM60 will stop making sensor measurements 
when the batteries are extremely low.

Press the TEST button to reset the logger.

https://www.metergroup.com/em60-support
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Table 2  Troubleshooting EM60 (continued)

Problem Possible Solutions

Sensor data shows No 
response from sensor in the 
Scan window
or
Downloaded data shows 
#N/A

The raw data measured by the logger is out of expected range for 
the sensor. This could be caused by an unplugged or broken sensor.

Ensure the sensor is fully inserted into the logger sensor port.

Ensure the sensor type shown in the Scan window matches the 
sensor connected to the logger.

Switch the sensor to a known working port and scan again. If the 
sensor shows data, the port may be damaged. If the No response 
from sensor is still presenting, the sensor could be unplugged 
or broken. 

If the problem persists, contact Customer Support.

Sensor measurement data 
does not seem to be correct

Switch the sensor to a known working port and scan again. If the 
problem follows the sensor, then the sensor may be damaged.

Many issues affect the quality of the sensor measurement. Please 
see the sensor user manual for troubleshooting.

Red ERROR light and/or 
green OK light are always on

Check logger batteries.

Press the TEST button to reset the EM60.

If the problem persists, contact Customer Support.

Red ERROR light is on after 
pressing the TEST button

See Section 3.2.3 for information on the TEST button results and 
how to further troubleshoot.

Cellular uploads stopped 
working (EM60G)

Check antenna.

Press the TEST button to reset the EM60.

Run the Cellular Communication Test in ZENTRA Utility to 
determine if there is a communication error.

Check the List Cellular Carriers in ZENTRA Utility to confirm there 
are cellular carriers operating in the area.

If the problem persists, contact Customer Support.

Logger does not seem to be 
working correctly or reliably

Press the TEST button on the logger to reset the EM60.

Check logger batteries. Replace alkaline batteries if close to 0%. 
Recharge NiMH batteries if close to 0%.

Check for corrosion or water damage. Check that the seals and 
gaskets are intact.

If the problem persists, contact Customer Support.
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5.3 CUSTOMER SUPPORT
NORTH AMERICA
Customer service representatives are available for questions, problems, or feedback Monday 
through Friday, 7:00 am to 5:00 pm Pacific time. 

Email: support.environment@metergroup.com 
sales.environment@metergroup.com

Phone: +1.509.332.5600

Fax: +1.509.332.5158

Website: metergroup.com

EUROPE
Customer service representatives are available for questions, problems, or feedback Monday 
through Friday, 8:00 to 17:00 Central European time. 

Email: support.europe@metergroup.com  
sales.europe@metergroup.com

Phone: +49 89 12 66 52 0

Fax: +49 89 12 66 52 20

Website: metergroup.de

If contacting METER by email, please include the following information: 

Name 
Address 
Phone

Email address 
Instrument serial number
Description of the problem

For products purchased through a distributor, please contact the distributor directly for assistance.

5.4 TERMS AND CONDITIONS
By using METER instruments and documentation, you agree to abide by the METER Group, 
Inc. USA Terms and Conditions. Please refer to metergroup.com/terms-conditions for 
details. For terms and conditions specific to EM60G data storage, refer to metergroup.com/
zentra-cloud-terms-conditions.

mailto:support.environment%40metergroup.com?subject=
mailto:sales.environment%40metergroup.com?subject=
https://www.metergroup.com
mailto:support.environment%40metergroup.com?subject=
mailto:sales.environment%40metergroup.com?subject=
https://www.metergroup.com/de
http://www.metergroup.com/terms-conditions
http://www.metergroup.com/zentra-cloud-terms-conditions
http://www.metergroup.com/zentra-cloud-terms-conditions
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APPENDIx A. COMPLIANCE CERTIFICATIONS
This appendix contains compliance statements that apply to the EM60 and EM60G.

A.1 USA
The following FCC statement applies to the EM60 and EM60G. This device complies with 
Part 15 of the FCC Rules. Operation is subject to the following conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may cause 
undesired operation.

The EM60 series loggers contain one or more of the following radio modules, listed by their FCC 
identification numbers:

• SH6MDBT40 (all EM60 series)

• XPYLISAU201 or XPYLISAU200 (EM60G only)

Changes or modifications to the EM60 series loggers not expressly approved by METER Group, 
Inc. USA could void FCC compliance and thus the user’s authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications.

There is no guarantee that a particular installation will not cause any interference. If this 
equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, METER encourage users to attempt to 
correct the interference by trying one or more of the following measures:
• Reorient or relocate the receiving antenna

• Increase the separation between the equipment and receiver

• Consult Customer Support
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A.2 CANADA
Industry Canada (IC) Notices

This Class B digital apparatus complies with Canadian CAN ICES-3(B) / NMB-3(B) and RSS-210. 
Operation is subject to the following two conditions:

• this device may not cause interference

• this device must accept any interference, including interference that may cause undesired 
operation of the device

The EM60 series loggers contain one or more of the following radio modules, listed by their IC 
identification numbers:

8017A-MDBT40 (all EM60 series)
8595A-LISAU201 or 8595A-LISAU200N (EM60G only)

Radio Frequency (RF) Exposure Information
This device has been evaluated and shown compliant with the IC RF Exposure limits under 
mobile exposure conditions (antennas are greater than 20cm from a person’s body).

Avis d’Industrie Canada (IC)
Cet appareil numérique de classe B est conforme aux normes canadiennes CAN ICES-3(B) / 
NMB- 3(B) et RSS-210.

Son fonctionnement est soumis aux deux conditions suivantes:

• cet appareil ne doit pas causer d’interférence

• cet appareil doit accepter toute interférence, notamment les interférences qui peuvent 
affecter son fonctionnement

Informations concernant l’exposition aux fréquences radio (RF)
Ce périphérique a été évalué et démontré conforme aux limites d’exposition aux fréquences 
radio (RF) d’IC lorsqu’il est installé dans des produits hôtes particuliers qui fonctionnent 
dans des conditions d’exposition à des appareils mobiles (les antennes se situent à plus de 
20 centimètres du corps d’une personne).

Changes or modifications to the EM60 series loggers not expressly approved by METER 
Group, Inc. USA could void Industry Canada (IC) compliance and thus the user’s authority to 
operate the equipment.

A.3 EUROPEAN UNION
R&TTED and European Conformance CE mark

Radiofrequency radiation exposure Information: this equipment complies with radiation 
exposure limits prescribed for an uncontrolled environment for fixed and mobile use conditions. 
This equipment should be installed and operated with a minimum distance of 20 cm between 
the radiator and the body of the user or nearby persons. This transmitter must not be co-located 
or operating in conjunction with any other antenna or transmitter except as authorized in the 
certification of the product.

A full CE declaration of conformity for the EM60 is available on request from METER Group.



39

EM60

A.4 JAPAN
TELEC (Japan)

The EM60 series loggers contain one or more of the following radio modules that are 
TELEC /JATE certified.

All EM60 series:

• Technical Requirements certified type number = 204-420020

EM60G with TELEC-approved cellular module:

• Technical Conditions certified type number = AD120274003 

• Technical Requirements certified type number = 003-120375
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